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Chapter 1 Introduction 

1.1 Topology Optimization (TO) 

Topology optimization (TO) is a computational method used to optimize the shape and layout of 

structures or components, while satisfying certain performance criteria such as minimizing weight 

or maximizing stiffness. The goal of topology optimization is to find the optimal distribution of 

material within a given design space, subject to certain constraints and objectives. This involves 

iteratively removing or adding material from the design space to achieve the desired performance 

criteria using finite element analysis (FEA). Topology optimization is competent at optimizing the 

shape of complex structures such as aircraft wings, car frames, or medical implants, and has 

applications in many fields such as aerospace, automotive, biomedical, and civil engineering. The 

optimization results can lead to more efficient and lightweight designs, reduced material usage and 

production costs, and improved performance and reliability. The design processes can benefit from 

topology optimization in terms of time and weight savings. 

1.2 Topology Optimization with 3D Printing 

While topology optimization is a powerful tool for designing optimal structures, it often produces 

complex and irregular shapes that can be difficult to interpret and manufacture. This makes it 

challenging for engineers to understand and implement the optimal designs, particularly if they are 

not familiar with the optimization algorithm. 3D printing, which is also known as Additive 

Manufacturing, can help bridge the gap between topology optimization and practical engineering 

applications, allowing designers to take full advantage of the benefits of topology optimization 

while overcoming some of its limitations. 

(1) Manufacturing complex geometries 

Topology optimization often produces complex and irregular shapes that can be challenging to 

manufacture using traditional manufacturing methods. 3D printing, however, can easily produce 

these shapes, making it an ideal manufacturing method for topology optimized designs. 

(2) Rapid prototyping 
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3D printing allows for the rapid production of prototypes, which can be used to validate topology 

optimized designs quickly and iteratively. This can help reduce the time and cost associated with 

traditional prototyping methods. 

 

Figure 1.1: Prominent features of topology optimization with 3D printing 

 

(3) Material flexibility 

With 3D printing, it is possible to print objects using a wide range of materials, including metals, 

polymers, and composites. This flexibility allows designers to choose materials that are most 

suitable for their specific application, taking into account factors such as strength, weight, and cost. 

(4) Design freedom 

3D printing removes many of the constraints associated with traditional manufacturing methods, 

such as the need for moulds or tooling. This allows designers to explore more complex and 

unconventional shapes, which may result in more optimized designs. 

(5) Integration with simulation software 

Many 3D printing software packages now have built-in simulation capabilities, allowing designers 

to simulate the behaviour of a part under load before it is printed. This can help validate topology 

optimized designs and ensure that they meet the desired performance criteria. 
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Overall, 3D printing can enable the implementation of topology optimization in practical 

engineering applications, as shown in Figure 1.1. Therefore, this guideline provides the methods 

and procedures on topology optimization for structures and components that are manufactured 

using 3D printing. Further applications of topology optimization for 3D printing is tabulated in 

Appendix A. 

  



 
 

 4 

Chapter 2 Topology Optimization Considerations  

2.1 Selection considerations  

Topology optimization is a powerful tool for designing lightweight structures, but it may not be 

necessary or appropriate for every part. Therefore, some considerations are proposed when 

deciding whether to perform topology optimization: 

(1) Weight consideration 

Topology optimization is a good approach to achieve weight reductions while maintaining 

required functions for parts and components. This should be the key consideration when deciding 

on whether to undertake topology optimization. 

(2) Design complexity 

Topology optimization can help reduce design time and improve performance for complex design 

requirements, such as multiple load cases or a combination of structural elements.  

(3) Material and manufacturing constraints 

The material properties and manufacturing constraints should be considered when deciding 

whether to do topology optimization. The final design should be manufacturable within the 

constraints of the available materials and manufacturing process. 

(4) Cost consideration 

The use of topology optimization can increase the cost of the design process. The additional design 

costs should be considered and justified by the potential benefits of the optimized design. 
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2.2 Design considerations 

Several design considerations are proposed when performing topology optimization for 3D 

printing of lightweight structures, as follows: 

(1) Geometrical constraints:  

The optimized design should be printable by the chosen 3D printing machine. The constraints and 

precision of the chosen 3D printing machine should be considered when performing topology 

optimization, such as the minimum feature size, the minimum thickness, the maximum overhang 

angle, and the maximum size of the build volume that can be printed. 

(2) Material properties 

The properties of the 3D printing materials can significantly impact the topology optimization 

process. For example, the stiffness, strength, and ductility of the materials should be considered 

when optimizing the design. 

(3) Post-processing requirements 

The post-processing requirements of the 3D printed parts should be considered, such as the surface 

finish, polishing, or painting. These requirements can influence the optimal design. 

(4) Performance requirements:  

The performance of the optimized design should meet the criteria after it is printed, such as the 

weight, strength and stiffness, etc. 

Overall, when performing topology optimization for 3D printing, it is important to take a holistic 

approach and consider all relevant design factors. This will help to ensure that the optimized design 

is suitable for 3D printing, meets the required performance criteria, and can be successfully 

manufactured. 
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2.3 Manufacturing Considerations 

When considering the manufacturing of a 3D printed part that has been optimized through 

topology optimization, there are several important considerations to propose, as follows: 

(1) Printing orientation 

The orientation of the part during printing has a significant impact on the final strength and quality. 

Therefore, the best orientation for the optimized design should be considered to ensure that the 

printed part meets the required performance criteria. 

(2) Support structures 

Complex geometries often require the use of support structures during 3D printing. The optimized 

design should reduce the number of supports and make the part easier for post-processing. 

(3) Machine parameters 

The machine parameters, such as the layer thickness, printing speed, and in-fill density can impact 

the quality of the printed parts. These parameters should be tuned and optimized for the chosen 

3D printing technology 

(4) Post-processing 

Depending on the chosen 3D printing technology and the specific design, post-processing may be 

required to achieve the desired surface finish or mechanical properties. The optimized design 

should be suitable for the required post-processing steps. 
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Chapter 3 Topology Optimization Methods 

3.1 Computational Setups  

The TO algorithm is initialized with a design domain that is user-defined. This domain then 

undergoes finite element analysis to evaluate the stiffness or compliance of every element in the 

domain. After obtaining the results of finite element analysis, sensitivity of each element is 

checked. An element with high sensitivity would mean it has greater influence on the mechanical 

property of the overall structure if removed. Generally, elements with low sensitivity will be 

removed and the processed domain will be filtered to deal with two major numerical problems: 

 

Figure 2.1: Algorithm and evolution of topology optimization 

 

(1) Checkboard problem in which elements are connected by edge nodes which introduces 

impractical mechanical properties.  
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(2) Mesh dependent designs that vary with the density of mesh. Domains with larger mesh tend to 

produce “chunkier” results while smaller mesh generate unreasonable fibrous thread-like 

configurations. The filtered domain is then evaluated to check for convergence.  

The reiterative process is illustrated by the flowchart in Figure 2.1. A common form of a 

topological optimization problem with single constraint is formulated as: 

Minimize or maximize 𝑓(𝜌) (1) 

Subject to volumetric constraint ∫𝜌
Ω

𝑑𝑉 ≤ 𝑉0  

Other constraint 0 ≤ 𝜌 ≤ 1  

where 𝑓(𝜌) is the objective function, Ω is the physical domain to be optimized, 𝑉0 is the total 

allowable volume of the final design and 𝜌 is the constraint on normalized material density that is 

between 0 and 1 to describe the presence of material at each finite element within the physical 

domain; 1 represents locations where density is defined while 0 is for locations where material is 

either removed or absent at the start of initialization. The above formulation possess a single 

(volumetric) constraint and can be solved through the optimality criteria method. 

On the other hand, to solve problems with multiple constraints, a general structural formulation is 

required. The multi-constraint problem can be formulated to find the set of design variables c: 

Minimize or maximize 𝑓(𝑐) (2)  

Subject to constraints 

𝑔(𝑐) = 0  

ℎ(𝑐) ≤ 0  

Other constraint 𝑐𝑙 ≤ 𝑐 ≤ 𝑐𝑢  

where 𝑓(𝑐) is the objective function, 𝑔(𝑐) and ℎ(𝑐) are general equality and inequality constraints, 

respectively, c is the vector of design variables, and 𝑐𝑙 and 𝑐𝑢 are the lower and upper bounds on 

the design variables which is similar to the constraint on the normalized density as described in 
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the formulation of the single constraint problem. In the case of multi-constraint topological 

optimization, the design variable c is the normalized material density 𝜌. Then 𝑓(𝑐), 𝑔(𝑐) and ℎ(𝑐) 

can be any mechanical response functions such as compliance, displacement, stress or even 

frequency. Therefore, a multiple constraint problem is more suitably solved by convex 

approximation method which utilizes the sensitivities between the current and previous design 

points for approximation of the objective and constraint functions, eventually leading to 

convergence towards optimized result. 

3.2 Numerical Algorithms 

3.2.1 Solid Isotropic Material with Penalization (SIMP) 

As a direct product of the homogenization method, commercial topology optimization software 

was progressively replaced by a less rigorous and more efficient method called the SIMP. SIMP 

was less rigorous due to its use of virtual isotropic materials as compared to the reliance on true 

composite materials by homogenization method. Instead of using true composite materials during 

the penalization phase of intermediate densities, the simple material interpolation involved in 

SIMP eliminates expensive modelling and computational demands. The removal of unnecessary 

expensive and time-consuming procedures is key to the common adoption of SIMP method in 

commercial topological optimization software. 

During the optimisation process, stiffness is evaluated using finite element method. Each finite 

element is then defined with a design variable, which is the normalized value for density between 

0 and 1 and assumed to be directly scaled with stiffness or the elastic modulus of each element. 

The result is a collection of data fields within a design domain filled with element densities of 

between 0 (no material) to 1 (full solid material) inclusive. An illustration of a structural bracket 

design space and raw topological optimization result adopted from nTopology [1], shows the 

distribution and interpolation of densities where regions in red correspond to highest densities 

followed by regions in blue and green with densities between 0 and 1 along with empty spaces 

with 0 density (Figure  2.2). These blue and green regions are deemed as “intermediate densities” 

which are not physically meaningful for a solid isotropic material as the basic concept of SIMP is 

to achieve optimal distribution of elements with density of only 0 and 1. This lack of proper 

definition of material requires a user-controlled penalization factor P to produce a more realistic 
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structure. The penalty factor mitigates the contribution of finite elements with intermediate 

densities to the total stiffness of the structures by steering these elements towards either full solid 

(density =1) or void (density = 0). A suitable penalty factor value of 3 is recommended from 

numerical experiments [2]. 

 

Figure 2.2: Structural bracket with topology optimization [1] 

 

3.2.2 Level Set Method 

Level set method (LSM) defines interfaces between material phases implicitly by iso-contours of 

a level-set function which facilitates the crystal-clear description of boundaries [3]. While SIMP 

directly removes the elements with low sensitivity, leaving a dispersion of holes with no inherent 

interconnectivity throughout the model, LSM approaches the problem by mapping out the 

distribution of relative sensitivity onto meshes in the form of contours shown in Figure 2.3. The 

aim of each iteration is to match the current target volume fraction with a threshold. Elements in 

contour regions with relative sensitivity less than this threshold (marked by dark blue and purple 

regions in Figure 2.3) are deleted and the analysis is rerun. Each newly updated domain will result 

in a new distribution of relative sensitivity and a new threshold is defined to match the current 

target volume fraction. This process is repeated till an optimum topology is achieved. The LSM 

approach is not suitable for 3D objects as it is immensely complicated to map out the sensitivity 

contours. 
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Figure 2.3: Level set process with iso-contour adopted from digital engineering [4] 

 

The clear definition of boundary can greatly improve accuracy as mechanical responses are 

captured in the proximity of boundaries. Improved accuracy reduces the ambiguity resulting from 

intermediate density phases using density-based approach. The smooth topological treatment of 

boundary also overcomes the checkerboarding effect found in density-based approach where 

alternating solid elements are connected only by corner nodes. The illogical connectivity by point 

will lead to unrealistic and spurious mechanical responses in these regions. 

LSM was reported to be highly reliant on the initial configuration, indicating a high degree of non-

convexity and nonlinearity which increase the probability of the optimization process converging 

to local minima instead of global ones [3]. The introduction of holes as illustrated in Figure 2.4 

can be useful but is not standardized across all designs which makes it difficult to guarantee that 

an improvement can be achieved in the optimization process. Even though the convergence 

problem can be solved with the use of regularization technique such as smoothening of sensitivity 

and geometrical mapping, the designer may not have a full control of the effect of regularization 

on the geometry of the final products leading to inconsistencies. 
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Figure 2.4: An initial design with hole nucleation [5] 

 

To summarize, the downside of SIMP is the lack of clarity in the boundary or fuzzy interface and 

LSM requires initial seedings of holes which introduces a large number of intersecting elements, 

negatively affecting the computational efficiency, robustness and accuracy of analysis. In order to 

eliminate the downsides resulting from either method, a combination of these two methods was 

introduced through a penalty term in the objective function [6]. Instead of initial dependence on 

large arbitrary number of holes in LSM, holes are seeded continuously throughout the optimization 

process with the size and shape of holes optimized for different design problems.  

3.2.3 Bi-direction Evolutionary Structural Optimization (BESO) 

Besides the three commonly used methods as discussed, Bi-direction Evolutionary Structural 

Optimization (BESO) is another commonly accepted method in commercial software. ESO 

method, where BESO originated from, is a process of gradual removal of unwanted, inefficient, 

and lowly-stressed material from an initially conservative design to achieve an optimal design [7]. 

The extent and speed of material removal in each iteration is controlled by user defined parameters, 

rejection ratio (RR) and evolution rate (ER), respectively. RR is the ratio of threshold Von Mises 

stress to a fixed stress, often defined by the yield stress of the material, such that elements with 

average stress below this threshold are removed. ER, on the other hand, controls the rate of increase 

of RR after each increment to facilitate the convergence of result toward the optimum. Typically, 
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1% of both RR and ER are sufficient for most cases [8]. Nonetheless, RR and ER should still be 

carefully adjusted to avoid premature convergence of results. Even with carefully determined RR 

and ER parameters, there is still uncertainty towards whether the solution is a local or global 

optimum.  

ESO is also deemed as unidirectional ESO because the optimal design is achieved in one single 

direction that is the removal of materials whereas the “bi-directional” in BESO suggests that the 

optimal design is obtained using two directions, namely removal and addition of materials. BESO, 

as compared to ESO, offers better ability in finding global minima by allowing “backtracking” of 

elements to ensure all possible designs are thoroughly explored which not only include designs 

realised by just removal of materials but also the addition or re-introduction of materials to 

alleviate high stress regions [7]. In contrast to elemental sensitivities, BESO utilizes nodal 

sensitivities computed by the weighted average of the connected elemental sensitivities. Therefore, 

the distribution of density and sensitivities can be interpolated and smoothed across the voids of 

deleted elements. This approach allows for potential alleviation of concentration of extreme 

stresses to improve the overall stiffness of the structure. BESO was not as widely adopted as SIMP 

or LSM because the search space is related to the complexity of the design domain. A highly 

complex design domain would significantly increase the possible design space that the algorithm 

has to search, leading to potential convergence problem and higher computational cost. 

3.3 Software for Topology Optimisation 

As shown in Table 2.1, it was reported that approximate fifty percent of the current commercial 

topology optimization software use purely density-based methods and a third of the market share 

belongs to a combination of both density-based and level-set methods, while the remainder are 

purely level-set or other evolutionary algorithms [9]. The most common density-based methods 

used to handle topological optimization in commercial finite element codes are Solid Isotropic 

Microstructure with Penalization (SIMP) and Bi-directional Evolutionary structural Optimization 

(BESO). 
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Table 2.1: Commonly used commercial software for topology optimisation (non-exhaustive) 

Software Company Application Algorithm 

Abaqus - TOSCA Structure Dassault Systems Multiphysics Density-based 

ANSYS Mechanical ANSYS Inc. Multiphysics Density-based 

MSC Nastran Optimisation MSC Structures Density- based 

OptiStruct Altair Engineering Structures Density- based 

Inspire solidThinking Inc. Structures 
Density & Level-

Set 

FEMtools Dynamic Design Solutions Structures Density-based 

COMSOL COMSOL Inc. Multiphysics 
Density & Level-

Set 

nTop Platform nTopology, Inc. Structures Density-based 
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Chapter 4 Applications 

In this chapter, OptiStruct is utilized to demonstrate the approach to conduct topology optimization 

of lightweight structures. The step to a simple example is shown here and will be applicable to 

more complicated problems.  

4.1 Set Up Model in HyperMesh 

4.1.1 Preparation and problem clarification 

▪ To demonstrate the workflow of topology optimization in OptiStruct, a shell structure is 

selected as an example to minimize its volume while maintaining strength. The CAD model 

and boundary conditions are shown in Figure 4.1. 

 

Figure 4.1: Geometry and boundary conditions 

 

▪ There are two constraints at the lower left and right corners of the shell respectively to fix 

the structure on the ground.  

▪ The shell structure is subjected to 4 force vectors at Point A, B, C and D, respectively. 
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▪ The objective is to minimize the volume fraction of the shell while maintaining the strength 

to withstand the applied forces. 

▪ Significant displacements can be found at Pont A, B, C and D due to the applied forces. 

Thus, the allowable displacements at these points must be predefined as a reference 

(dconstraints) for topology optimization. 

▪ The design variable is density, varying from 0 to 1. The portion with a density value of 0 

is the part removed during the optimization. 

 

Objective Minimize volume fraction. 

dconstraints 

Point A: displacement in the x-axis 0 < Δx < 0.002mm. 

Point B: displacement in the x-axis -0.002mm < Δx < 0. 

Point C and D: displacement in the y-axis -0.002mm < Δx < 0. 

Design variables The density of each element in the design space. 

 

4.1.2 Import Geometry and Generate Mesh 

▪ Launch HyperMesh and select OptiStruct from the User Profile menu. 

▪ From the File menu in the toolbar, select Import > Geometry. 

▪ Select the geometry file from your working directory and then click Import to load the 

model into HyperMesh. 
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Figure 4.2: Import geometry 

 

▪ From the File menu on the toolbar, select Mesh > Create > 2D AutoMesh. 

 

Figure 4.3: Create 2D AutoMesh 

 

▪ Click on the geometry where you want to create a mesh. 

▪ Enter an element size in the Panel. [0.0001] 

▪ Select a suitable mesh type from the drop-down list. [quads only] 

▪ Then, Click mesh. 
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Figure 4.4: Mesh setup 

 

4.1.3 Create Materials 

▪ Click Materials from the Panel to create a material. 

▪ Type in a mat name that you want to use. [Steel] 

▪ Click type to select a suitable type from the drop-down list. [Isotropic] 

▪ Click card image and select MAT1. 

▪ Click create/edit to open the MAT1 table. 

 

 

Figure 4.5: Create materials 

 

▪ Click the material parameters which you want to define and type in their values, 

respectively. 

▪ E is the Young’s modulus, Nu is the Poisson’s ratio, and RHO is the mass density. 
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Figure 4.6: Material parameters 

 

▪ Click return to go back to material collectors, and then click create. 

4.1.4 Create Properties 

▪ Click Properties from Panel. 

▪ Type in a prop name. [pshell] 

▪ Click type and select a type from the drop-down list. [2D] 

▪ Click card image and select PSHELL from the drop-down list. 

▪ Click material and select the material that you have created in Figure 4.5. [Steel] 

 

Figure 4.7: Create properties 

 

▪ Click create/edit to open the PSHELL table. 

▪ Click [T] to activate the thickness field for the shell component and accept the default value 

of 1. 
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Figure 4.8: Thickness of shell 

 

▪ Click return and go back to the Properties. 

▪ Then click create and return. 

4.1.5 Assign Materials and Properties to Components 

▪ Click Components from the Panel. 

▪ Click comps and select the component which you want to assign the material and 

properties. 

▪ For property, type in the name of properties created in Figure 4.7. [pshell] 

▪ Click update. 

 

Figure 4.9: Assign materials and properties to components 

 

4.1.6 Create Loader Collectors (Constraints and Forces) 

▪ Click Load Collectors from Panel to create constraints. 
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▪ Type in a loadcol name in the Panel. [spc] 

▪ Click create and return. 

 

Figure 4.10: Create load collectors (constraints) 

 

▪ On the right side of the Panel, select Analysis. 

 

Figure 4.11: Analysis > constraints 

 

▪ Then, click constraints to open the constraint dialog. 

▪ From the Panel, click nodes. 
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Figure 4.12: Constraints 

 

▪ On your mesh, click an element node where you want to apply a constraint.  

▪ Tick the dof which you want to constrain. In this case, dof1, dof2 and dof3 are selected. 

▪ Click create. 

▪ Repeat the procedure until all the constraints are created. In this case, there are 2 constraints 

on the left and right sides, as shown in Figure 4.12. 

 

Figure 4.13: Create load collectors (forces) 

 

▪ Click Load Collectors from Panel again to create the load collector for forces. 
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▪ Type in a loadcol name in the Panel to name the force boundary conditions. 

▪ Click create and return. 

▪ From Analysis panel, click forces to open the force dialog, as shown in Figure 4.14: Force 

Vectors. 

 

Figure 4.14: Force vectors 

 

▪ From the Panel, click nodes. 

▪ On your mesh, click an element node where you want to apply a force vector. 

▪ Click magnitude and type in a value. 

▪ Click the button below magnitude and select the direction of the force vector, such as, x-

axis, y-axis, and z-axis, etc.  
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▪ Click create. 

▪ Repeat the procedure until all the force vectors are created.  

▪ In this case, there are 4 force vectors applied on Point A, B, C and D respectively, as shown 

above. The force directions at Point A and B are both x-axis, while the directions at Point 

C and D are both y-axis. The magnitudes of all the forces are 10. 

▪ Then, Click return. 

4.1.7 Create Load Cases 

▪ From the Analysis page, click loadsteps. 

▪ Type in a name for the loadstep [loadsteps1]. 

▪ Set type as linear static. 

 

Figure 4.15: Create load cases 

 

▪ Check the box for SPC. An entry field appears to the right of SPC. 

▪ Click on the entry field next to SPC. 

▪ From the drop-down list, select the load collector of constraints, which is under the 

loadcol name [spc] you have created in Figure 4.15. 

▪ Similarly, check the box for LOAD and select the load collector of forces from the drop-

down list. It is under the loadcol name of force boundary conditions [forces] created in 

Figure 4.15. 

▪ Click create and return to go back to the Analysis page. 
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4.2 Linear static Analysis 

A linear static analysis is performed before the topology optimization to investigate the responses 

of the structure, especially the displacements. Therefore, the linear static analysis provides 

references to define the target constraints in the topology optimization. 

4.2.1 Model Setup 

▪ From the Analysis panel, click OptiStruct. 

 

Figure 4.16: Launch OptiStruct 

 

▪ Click save as and select the directory to write your OptiStruct model file. 

▪ Click run options and select analysis. 

▪ Click OptiStruct to run the simulation. 

 

Figure 4.17: Set linear static analysis 

 

▪ The simulation progress will be shown in a pop-up window. Close the window after the 

analysis has converged. 
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4.2.2 Displacement Analysis 

▪ From the OptiStruct panel, click HyperView to check the results. 

▪ Click Plot, and select Displacement as the results type, as shown in Figure 3.18. 

 

Figure 4.18: Plot displacement 

 

▪ Click Apply to visualize the displacements contours. 

 

Figure 4.19: Displacement contour 
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▪ For this case, the maximal displacement is about 0.001. Therefore, the target maximal 

displacement after topology optimization can be set as 0.002. 

▪ Close HyperView and click return in HyperMesh. 

4.3 Topology Optimization 

4.3.1 Create Topology Design Variables 

▪ From the Analysis page, click optimization > topology. 

▪ Click desvar and type in a name [design]. 

▪ Click props and select the properties defined in Figure 4.7 [pshell]. 

▪ Set type [PSHELL]. 

▪ Set base thickness to be 0.0. 

▪ Click create and return. 

 

Figure 4.20: Create design variables 

 

4.3.2 Create Volume Response 

▪ From optimization panel, select responses. 

 

Figure 4.21: Create response 
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▪ Click response and name the response as vol, as shown in Figure 4.21: Create Volume 

Response. 

▪ Switch the response type to volume. 

▪ Click create. 

 

Figure 4.22: Create volume response 

 

4.3.3 Create Displacement Responses 

▪ From optimization panel, select responses again. 

▪ The displacement responses refer to as the behaviours induced by the input force vectors. 

Therefore, each force vector should correspond to a response. 

▪ Type in a name [displace1] to create a response induced by the force at Point A. 

▪ Switch the response type to static displacement. 

 

Figure 4.23: Create displacement response 

 

▪ Click nodes and select Point A from the mesh. 

▪ Select the dof according to the force direction at Point A. [dof1] 

▪ Click create. 
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▪ Repeat the procedure and create the responses [displace2, displace3, displace4] at Point 

B, C and D. 

▪ Click return to go back to the Optimization panel. 

4.3.4 Create Constraints on Displacement Responses 

 

Figure 4.24: dconstraints 

 

▪ From optimization panel, select the dconstraints and create constraints to each 

displacement response. 

 

Figure 4.25: Create constraints on displacement responses 

 

▪ Click constraint and name the constraint as con1 for displace1. 

▪ Click response and select displace1. 

▪ Check the boxes for upper and lower bounds and set the values according to the maximal 

displacement calculated from the linear static analysis. [0.002] 

▪ Click loadsteps. 

▪ Check the box near loadstep1 and click select. 

▪ Click create. 

▪ Follow the same step, create con2 for displace2, con3 for displace3 and con4 for displace4. 
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▪ Click return to go back to the optimization panel. 

▪ In this case, the lower bound is -0.002 and the upper bound is 0.002. For con1, activate the 

upper bound, while for con2 to con4, activate the lower bound. 

4.3.5 Create Objective for Topology Optimization 

▪ From optimization panel, select the objective. 

 

Figure 4.26: Objective 

 

▪ Set the objective as min to reduce the vol of the structure. 

 

Figure 4.27: Create objective - volume optimization 

 

▪ Click response and select vol. 

▪ Click create. 

▪ Click return and exit the optimization panel. 

4.3.6 Implement Topology Optimization in OptiStruct 

▪ From the Analysis panel, click OptiStruct. 

▪ Click save as and select the directory where you would like to save the model file. 
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▪ Click run options and select optimization. 

▪ Click OptiStruct to run the simulation. 

▪ The simulation progress will be shown in a pop-up window. Close the window after the 

analysis has converged. 

4.3.7 Post-process Optimization Results 

▪ Go back to HyperMesh and click HyperView, which is the post processing tool inside 

HyperMesh. HyperView will load your optimization results and pop up on your screen. 

▪ From the result browser, select the last iteration. 

 

Figure 4.28: Launch the last iteration 

 

▪ From the panel, click Iso to plot the optimization results. 

▪ For Result type, select Element Densities.  

▪ Click Apply. 

▪ To change the density threshold, drag the slider under the Current value. 
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Figure 4.29: Plot topology optimization results – iso values 

 

▪ The optimization result will be plotted in HyperView, as shown below. 

 

Figure 4.30: Topology optimization (element densities) 

 

▪ Click Next Page on the upper right corner to plot the displacement contour. 

▪ Click Contour and select Displacement as the result type, as shown in Figure 3.31. 

▪ Slide the status to the end. This will show the deformations induced by the applied forces. 
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Figure 4.31: Plot displacement results  

 

▪ Click Apply and you will see the displacement contour as below. 

 

Figure 4.32: Displacement distribution after optimization 
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Appendix A Applications of Topology Optimization 

 

Table A-1: Summary of applications to topology optimization 

 

Papers Reference Original part Optimised part Objective 
Method/ 

algorithms 

Path-designed 3D 

printing for 

topological optimized 

continuous carbon 

fibre reinforced 

composite structures 

[10] 

  

Propose a path-designed 3D (PD-

3D) printing approach that takes 

into consideration of the load 

transmission path, and the 

anisotropic property of continuous 

carbon fibre reinforced filaments. 

SIMP 

Comprehensive View 

on Racing Car Upright 

Design and 

Manufacturing 

[11] 

  

Design of a racing car upright 

using topological optimization 
SIMP 

Design and analysis of 

prosthetic foot using 

additive 

manufacturing 

technique 

[12] 

 
 

Design and analysis of Prosthetic 

foot using additive manufacturing 

technique dealing with the 

complete design process of a 

motion prosthetic foot 

manufactured by using Poly lactic 

acid (PLA) material 

SIMP 
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Impacts of the settings 

in a design for 

additive 

manufacturing process 

based on topological 

optimization 

[13] 

 
 

To assess the impacts on part 

geometry of different design 

optimization settings used in the 

additive manufacturing process. 

SIMP,  

Level-Set 

Case Studies in 

Topological Design 

and Optimization of 

Additively 

Manufactured Cable-

nets 

[14] 

 

 

 

Discusses research in novel 

approaches to the topological 

design and optimization of cable-

nets enabled by the additive 

manufacturing of elastomeric 

materials. 

SIMP,  

BESO 

Experimental and 

numerical thermal 

analysis of open-cell 

metal foams 

developed through a 

topological 

optimization and 3D 

printing process 

[15] 

  

thermal analysis and comparing a 

lattice model and an optimized 

model of open-cell metal foams 

manufactured using metal casting 

process 

FEM 

Topology 

optimization and 

additive 

manufacturing: 

Comparison of 

conception methods 

using industrial codes 

[16]  
 

 

Comparison of TO results using 

various industrial codes, including 

Abaqus and Optistruct 

SIMP 
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The design of 

lightweight gas 

turbine engine parts 

using topology 

optimization 

[17] 

  

Address a new approach to 

designing aircraft engine parts 

using the topological optimization 

algorithm tailored for production 

by additive manufacturing. 

SIMP 

Additive 

manufacturing 

integration with 

topology optimization 

methodology for 

innovative product 

design 

[18] 

  

Evaluate the potentiality offered 

by the integration of two 

structural optimization approaches 

(topological and lattice structures 

design) to generate novel and 

better performing structures 

SIMP 

An efficient and 

scalable approach for 

generating 

topologically 

optimized cellular 

structures for additive 

manufacturing 

[19] 

  

Non-concurrent TO approach, 

choosing a uniform microstructure 

or Representative Volume 

Element (RVE) to optimize the 

macrostructure. 

Homogenization 

Method,  

SIMP,  

ESO,  

BESO,  

Level-Set 

Topological design 

and additive 

manufacturing of 

porous metals for 

bone scaffolds and 

orthopaedic implants: 

A review 

[20]  

 

Reviews topological design and 

manufacturing processes of 

various types of porous metals, in 

particular for titanium alloys, 

biodegradable metals and shape 

memory alloys. 

SIMP,  

ESO,  

BESO,  

Level-Set 
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Support structure 

constrained topology 

optimization for 

additive 

manufacturing 

[21] 

  

Develop a TO methodology for 

limiting the support structure 

volume, thereby leading to 

designs that are AM friendly. 

Level-Set 

Topology 

Optimization in 

Aircraft and 

Aerospace Structures 

Design 

[22] 

  

Review recent advances of 

topology optimization techniques 

applied in aircraft and aerospace 

structures design. 

SIMP, ESO, 

Level Set, Bubble 

method, Smooth 

Heaviside 

parameterization, 

Finite circle 

method 

Living on the Moon: 

Topological 

Optimization of a 3D-

Printed Lunar Shelter 

[23]  

 

To assess the concept of 3D 

printing technology as a potential 

method to build a habitat on the 

Moon. 

D-Shape 

High performance 

automotive chassis 

design: a topology 

optimization based 

approach 

[24] 

  

Simulate chassis weight reduction 
SIMP,  

Level-set 
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Topology 

optimization and 3D 

printing of large 

deformation compliant 

mechanisms for 

straining biological 

tissues 

[25] 

 
 

To design large deformation 

compliant mechanisms for 

inducing desired strains in 

biological tissues 

FEM 

3D printing of a post-

tensioned concrete 

girder designed by 

topology optimization 

[26] 
  

To present a novel design and 

manufacturing process that 

combines 3D concrete printing, 

topology optimization, and post-

tensioning of concrete structures. 

FEM 

Multidisciplinary 

topology optimization 

incorporating 

process-structure-

property-performance 

relationship of 

additive 

manufacturing 

[27] 

  

To incorporates the PSPP 

relationships of laser sintered 

material with topology optimizer 

to provide a 

guideline for TO collaborative 

AM design. 

FEM 

A novel bionic-based 

substructure division 

method for topology 

optimization 

[28] 

  

To propose a bionic-based 

substructure division method, 

which achieves better 

performances than traditional 

topology optimization methods. 

FEM 
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Full-scale topology 

optimization for fiber-

reinforced structures 

with continuous fiber 

paths 

[29] 

  

To propose a topology 

optimization method that is 

capable of simultaneous design 

for the structural topology, 

continuous fiber path, and 

morphology for fiber-reinforced 

composite structures. 

FEM 

Topology 

optimization of self-

supporting structures 

for additive 

manufacturing with B-

spline 

parameterization 

[30] 

  

To present a B-spline based 

topology optimization method to 

design self-supporting structures 

for additive manufacturing 

B-spline 

parameterization 

Development of a 

patient-specific 

immobilisation 

facemask for radiation 

therapy using additive 

manufacturing, 

pressure sensors and 

topology optimisation 

[31] 

 
 

TO of the 3D printed facemask 

(FDM) for volume reduction + 

maintaining mechanical strength 

SIMP 

Design and 

Development of an 

Additive 

Manufactured 

Component by 

Topology 

Optimisation 

[32] 

  

TO of a rear uprights for a 

suspension assembly fabricated by 

EBM 

SIMP 
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Bidirectional 

Evolutionary 

Structural 

Optimization (BESO) 

based design method 

for lattice structure to 

be fabricated by 

additive 

manufacturing 

[33] 

  

TO of thickness distribution of 

lattice struts to be fabricated 

through AM 

BESO 

An aerospace bracket 

designed by thermo-

elastic topology 

optimization and 

manufactured by 

additive 

manufacturing 

[34] 

 
 

TO of both Thermo-Elastic and 

Mechanical stresses on an 

aerospace bracket to obtain 

optimal design fabricated through 

SLM 

RAMP 

Design and 

experimental 

validation of self-

supporting topologies 

for additive 

manufacturing 

[35] 

 
 

TO of Messerschmidt–Bölkow–

Blohm (MBB) beams to validate 

the manufacturability of self-

supporting topological structures 

(FDM) 

SIMP 
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Topology 

Optimization of 3D-

printed joints under 

crash loads using 

Evolutionary 

Algorithms 

[36] 

  

Optimisation of 3D-printed metal 

joint in a hybrid S-rail structure 

under axial crash loading, and 

comparing the effectiveness of the 

design with other state of the art 

methods (Equivalent Static Loads 

(ESL) and Hybrid Cellular 

Automata (HCA)) 

EA-LSM 

Material extrusion 

additive 

manufacturing and 

experimental testing 

of topology-optimised 

passive heat sinks 

using a thermally-

conductive plastic 

filament 

[37] 

 
 

TO is used to generate novel heat 

sink designs for passive cooling 

through natural convection, which 

are printed using Fused Filament 

Fabrication (FFF) and tested for 

its thermal performance 

MMA 

Optimal design and 

experimental 

validation of 3D 

printed soft pneumatic 

actuators 

[38] 
 

 

TO is used to optimise the design 

of a soft pneumatic actuator that is 

to be prototyped by 3D printing 

and tested under pneumatic 

pressure, and compared with the 

traditional rectangular unit cells 

design of a non-optimised 

actuator 

MIST 
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Hands-free printed 

door opener to limit 

the spread of 

Coronavirus: Design 

through topology 

optimization 

[39] 

  

Hands-free door openers were 

designed using TO and the 

efficiacy of both the classic SIMP 

approach and the NURBS based 

SIMP approach were compared 

based on both mechanical and 

manufacturing constrains 

SIMP 

Multiple-Material 

Topology 

Optimization of 

Compliant 

Mechanisms Created 

Via PolyJet Three-

Dimensional Printing 

[40] 

  

The design of multimaterial 

compliant mechanisms was 

optimised using the 2-phase SIMP 

approach, 3-phase combinational 

SIMP approach and the 3-phase 

multi-phase SIMP appraoch, and 

the efficacy of these optimisation 

approaches are tested through the 

multimaterial Polyjet printing of 

force inverter compliant 

mechanisms 

SIMP 

Support structure 

constrained topology 

optimization for 

additive 

manufacturing 

[21] 

  

A topology optimisation 

framework was tested for both a 

2D MBB beam and a 3D mount 

bracket to reduce the amount of 

support materials needed in 

fabricating these parts (through 

FDM) 

PareTO 
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Topology 

Optimization, 

Additive Layer 

Manufacturing, and 

Experimental Testing 

of an Air-Cooled Heat 

Sink 

[41] 

 
 

The design of design a heat sink 

for confined jet impingement air 

cooling is optimised, printed using 

additive layer manufacturing 

(ALM) and tested against 

benchmark plate and pin-fin heat 

sink geometries 

MMA 
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